Content Creation, Cropping, and GPS

Overview

| like that term; “content creation”. | always associate it with “inert filler”. For
geologists using GIS, there’s no end to the situations in which map details will need
to be added or modified. For instance, contacts, faults, sample locations, tracks, etc.
etc. As with so many other things we’ve done in GIS, there are many ways map
details can be added or modified. | will just be demonstrating one way... it may well
not be the easiest or fastest... it's just one way.

Custom Annotation

All sorts of annotation and objects (aka objects) can be drawn directly on an
ArcMap project using the Drawing toolbar.

Draw
Drawing ~ R (=) |Ej£j ﬂ“f-‘%ria' ~| |1':' ~| B I U |£' &

A

We've already looked at the labeling tool,

C
, when we custom placed contour
[

line elevations. One of the most frequently used graphics is the callout., ﬂ Use
it for a rather informal but easily visible note on a map. Click on the point at which
you want to callout to originate then drag to the position you want the text to appear.
Enter text using the input box that appears when you release the right mouse button.

’ This is the inside of Battery Pringle

4

B

| should note that the “post it note yellow” is very ESRI and folks can always spot
something done with an ESRI product from it.

A
Use the annotate button to add text directly on the map. Font, size, and color
of the text may be selected from the drawing toolbar.
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Battery Pringle

The splined text tool, ¥ |, is a convenient way to custom label a curved feature
such as a river or contact. Select the tool and click at the point at which labeling is
to start. Trace out the feature with successive clicks and double click at the ending

position for the label. Type in the text you wish to have displayed and click the “OK”
button.

With all of these four custom annotating tools, you may change the text or font style
by double clicking on the annotation which will bring up this box.
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2| x|

Text | Size and Position I

Text:

our annotation will appear here. ;I

ki _*I_I
Forit: |mia|1n.nn Ig gl El gl
Angle: IEI.EIEI _I? Character Spacing: IEI.EIEI _I?

Leading: Q.00 _:I

About Formatting Test | Change Symbaol... |

] I Cancel | Apply |

Everything in this box should be self explanatory by now (icons are identical to those
in word processing programs).

Adding graphics directly to a theme

Adding graphics to a theme may also be done using the drawing toolbar and
e

o A e

: : @ :
one of the various drawing tools . Use of these tools is easy and

o L [-1
intuitive. draws a new rectangle, draws a new polygon, etc. » ~* and

[ !
e | draw new unsplined and splined lines respectively. _____ draws a “freehand”
line (unlike the previous line creating tools, it is used by clicking and dragging).

Adding new Features to a new (or existing) theme

In many, perhaps most, situations, it is a good idea to add additional features
and graphics to a new theme which may be overlain on an existing theme rather
than adding graphics to the existing theme. For instance, if you were annotating the
geologic map of Kentucky to show stops on a field trip, it would make more sense to
make a new theme containing only the trip information rather than altering the
geologic map of Kentucky and thereby making it unsuitable for future use.
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Start by creating a new shapefile t6heme with ArcCatalog by clicking the

on ArcMap or launching it from the Start menu.

~J ArcCatalog - ArcView - C:\meteor

Eile Edit Yiew Go Tools Help
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B s | @aa @0 x

Location: II::"-.metecur ;I
Stylesheet:  [FLOC Eor H 5y 5
' x| Conterts | F'reviewl Metadatal
& Catalog = | .
o _Mame Type 1=
; _ B calc Raster Dataset
"D ChriverinstTernp & ctour2.shp Shapefilz
--{:I Docurnents and Settings B ctour S:Shp Shapefile
"D ESRI | & ctourd.shp Shapefile
"D iagciats &l cutter.shp Shapefile
"a metaor B hehadez Raster Dataset
"D mfzk.1_13 B rmeteor Raster Dataset
- mf2k_guwt @ meteorz Raster Dataset
-0 MSDERelA rheteor2, dddf Info Tahle
- Multimedia Files meteor2, ddom Info Table
& My Downloads meteor2.ddsh Info Table | |
-0 My Music meteor2.dgaa Info Tahle
-3 Palm meteorz2.dogcg Info Tahle
&1-& Program Files metear2.dghl Info Table
-2 temp meteor2.dglc Info Table
-0 VSTASCAN o || 5 Meteor2.dapa nfo Tabte .
4| | _}I—IL‘__\mn 2 iden r'ui"n:un _}I—I

#

Navigate to the location where you’d like to save the new shapefile (give this
some thought... putting it in an inappropriate or difficult to get to location will cause

problems further down the road). Right click on the folder in which you'd like to

place the new shapefile, pull down to “New” and select “Shapefile”.
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Create New Shapefile 7| x|

M arne; INEW_S hapefile

Feature Type: I Foint LI

— Spatial Reference

Descriptian:
Inknown Coordinate System ;I

K _'*I_|
[T Show Details Edit... |

[T Coordinates will contain b values. Uszed to store route data,
[T Coordinates wil contain £ values. Used to store 30 data.

ok I Cancel

Give the new shapefile some appropriate name. It's important to select the
shapefile type. If you're going to use it to show stop locations, “points” may be
appropriate. Lines would be appropriate for trip routes and polygons might be
appropriate for outcrop maps. Although not essential, it's a very good idea to specify
some projection system... it probably makes the most sense to use the projection of
the map over which the new theme is to be placed.

Bring the new theme you created into the project containing your base map(s)
and start the editor tool.

J Editor « HT| 2~ | Task: ICreate Mew Feature j | Target: |new_area E |—-*" (=) | ps | ‘

We've used this tool before so everything should be familiar. Make sure that
the target window is showing that you’re making changes to your new shapefile not
the base map. Note that by changing the task and tool you can move the entire

feature or single points of the feature. Use the @ tool to rotate a feature.

Don't forget that you can also modify the attributes table of your new shapefile.
Add new fields to add information about each feature. This information can be used
for annotating and labeling your map later.
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Cropping a shapefile

We've already cropped a raster dataset last week. | wish that ESRI used the
same procedure for cropping a shapefile... but they don’t (although it starts the
same way). The first thing to be done is create or procure a polygon shapefile with
the “cookie cutter” shape for cropping. It's essential that this shapefile be a polygon.
You may either create it using the same procedure we did above or you may modify
an existing file, such as the Ohio County Boundary map we used before. Select
Tools>Geoprocessing Wizards.

GeoProcessing Wizard x|

Choose a GeoProcessing operation, then click the About Clip

Mext button to chooze optionz. . . .
This operation uses a clip

layer like a cookie cutter an
your input layer. The input
" Digsolve features bazed on an attribute layer's attributes are not

altered.
i~ Merge lavers together

%' Clip one layer bazed on ancther /’ﬁ + O = @

™ Interzect two layers Input Clip Result
Layer Layer Layer

™ Union bwo layers

tare about Clip... |

< Back I M et > I Cancel |

Specify “Clip one layer based on another” and click next.
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GeoProcessing Wizard x|

1. Select the input layer ba clip: About Clip

This operation uses a clip
layer like a cookie cutter an
your input layer. The input
layer's attributes are not

[T | Use selected features only

Murnber of features: 1

2. Select a polygon clip laver: altered.
IEDDkiE Cutter ;I
[T | Uze selected|features only ”< + O = @
Murnber of features: 1
Input Clip Result

3. Specify the output zhapefile or feature clasz

Layer Layer Layer
II::"-.DI:n:uments and Settingz“AdministratoriDe ﬁl

tare about Clip... |

< Back I Finizh I Cancel |

Select the shapefile to be cropped in the top window (ESRI uses the verb “clip”
rather than “crop”) and the shapefile to crop (clip) to in the middle window. Make
sure you specify the name and location of the output (cropped) shapefile in the
bottom window. When you press “Finish”, a new shapefile cropped to the clipping
file will be created and added to the project. Note: the original shapefile will be left
unaltered.

Using data collected with a GPS

There are many situations in which you’ll want to display data collected with a
GPS on a map. We'll start be assuming you know how to use your GPS and how to
collect data with it. | own a Garmin GPS V (and love it). | can collect individual
positions as “waypoints” and multiple points along a traveled lines as “tracks”.
These data can be easily downloaded from the GPS as ASCII files on my PC. We'll
start with these ASCII files.

Read the data into Excel. Remember the data files will not show up unless you
specify “All Files” in the “Files Type” window.
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Open

Look in: I@ My Docurnents ;I - 8 X o ~ Tools ~
: Mame © | Size | Type -

] LS S1KB Microsoft b
Histary #]Trimble Surveying GPS 15 KB MicrosoftE
[ The Library Committee met January 15 24 KB Microsoft
@ ] test 24 KB Microsoft b
)silicate Structres 404 KB Adobe Ach
My Documents | |367504 T4 assignments 18 KB Mlicrosoft E
frrRon wilson's aphorisms 1,065 KB Microsoft y
m [Froposal to Jointly Purchase Surveying GPS S... 31 KB Microsofth
[ rinutes of January 15 Library committee 32 KB Microsoft b
Desktop 19 mfgui quide v4 302 KB Adobe Ach
Literan:y Project 21 KB Microsoft
% @Kuhrs, Fussell 1,171 KB Carwvas 7L
— @Kuhrs, Fuszell 2 1,187 KB Carwvas 7L

Mlkohrs 3 422 KB Adobe ﬂu:ri_l'

= 4 | >
grs File narme: = -
Pl Mebwark - I _I ﬂu
Places  Files of type:  ETSTECAMMGIRG—_————— - Cancel_|

Because the files are not Excel worksheets, Excel will launch a wizard to help you

define your data.

Text Import Wizard - Step 1 of 3

The Texk Wizard has determined that your data is Delimited,
If this is correck, choose Mext, or choose the data type that best describes vour data,

21

riginal data bype
Choose the file type that best describes your daka:

- Characters such as commas or tabs separate each field,
- Fields are aligned in columns with spaces between each field,

i~ Fixed width

Skart impork ak row:

=

Preview of file Ci\Documents and SetkingstAdministrator Deskiopt GRS Y logs, Ext,

File origin:

932 1 Japanese (Shift-115)

=)

|1 Bridilat /Lon hdddinm . mmm' -

|2 DatunOWEsS 24

13 |

|4 HeaderONaneOStart TimeOElapsed TimeOLengthOlwverage Speed

H =

i i
Cancel | = Back | Blexk = I Eirish |

Garmin’s data is tab-delimited by default so | press “Next”
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Text Import Wizard - Step 2 of 3 2| x|

This screen leks wou set the delimiters your data contains, ¥ou can see
hiow wour bext is affected in the preview below,

elimiters
v Tab [ Semicalon [~ Comma

[T space [ Qther: I Text gualifier: I "I

[ Treat consecutive delimiters as one

~Daka preview

Grid at/Lon hddd0nw . miom ' -
[atuam GE 84
Header flame Prtart Time [Elapsed Time [Length Rweradg

K

Eile Edit Yiew Insert Format Tools Data  ‘Window Help Adobe POF -8 X
[0 2 arial o x|B I U EE %, WiN EIE| LS A L
i3 %3 = S ¥a | ¥ W ¢S | wereply with Changss... End Review.., .
™
A1 - B Grid
A B I C | 0 JEJ F [ &6 [ H | =
1 |Grid Lat/Lon hddddrmm. mmm’ =
| 2 |Daturn WiGE G4
3
| 4 |Header  Mame Start Time Elapsed Ti Length Average Speed
5
| B |Track ACTIWE LOG 3/27/72004 11:29) 2:16:45 125 m 55 mph
7
| 8 |Header  Position Time Altitude  Depth Leg Lencleg Time | Leg SpeedLeg Course
9
ETrackpoint M41 52,883 WE7 39155 | 372772004 11:29 764 ft
| 11 |Trackpoint M41 52,893 W87 39.158 | 372772004 11:31 B42 ft B3 ft 0:02:19/0.31 mph 3470 true
| 12 |Trackpoint M41 52875 W87 39.147 | 37272004 11:31 B34 ft 119 ft 0:00:07 12 mph 1560 true
| 13 |Trackpoint M41 52875 W87 39.134 | 372772004 11:31 B30 ft 62 ft 0:00:10/4.2 mph 890 true
| 14 |Trackpoint M41 52875 W87 39.132 | 372772004 11:31 B28 ft 7 0:00:15/0.30 rmph 890 true
| 16 |Trackpoint M41 52875 W87 39.132 | 372772004 11:32 6258 ft 0ft 0:00:16|0 rph 0o true
| 16 |Trackpoint M41 52875 W87 39132 | 3/27/2004 11:32 B2 ft 0ft 0:00:01 /0 raph 0o true
| 17 |Trackpoint M41 52901 W87 39.118 | 3/27/2004 11:32 B27 ft 170 ft 0:00:0258 mph 220 true
| 18 |Trackpoint M41 52952 W87 35120 | 3/27/2004 11:32 B23 ft 312 ft 0:00:15/14 mph 3590 true
| 19 |Trackpoint W41 52984 W87 39117 | 3/27/2004 11:32 515 ft 191 ft 0:00:0914 mph 30 true
| 20 |Trackpoint M41 52984 W87 39103 | 3/27/2004 11:32 514 ft 67 ft 0:00:04 11 mph 870 true
| 21 |Trackpoint M41 52,985 W87 39.082 | 372772004 11:32 614 ft 93 ft 0:00:04 16 mph 870 true | _
H o4 » >||\G'PlE".‘\|‘f logs / R m| ' _b”J
Draw - [¢ | AutoShapes- ™~ " [ O 4l
Ready v
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Although all the data is interesting (did | exceed the speed limit), I'm most interested
in where I've been so | eliminate all other data. Except column B. Now we have to
get the positional data into a form readable by other software packages. There are
many possible formats but perhaps the most usable is digital degrees. First let's
separate latitude and longitude into separate columns. Highlight the position
columns.

E3 Microsoft Excel - GPS V logs

File Edit ‘“iew Insert

O

2 prial

sl o
A2 - A M4152.883 WET 29155

Format Tools Data Window Help Adobe PDF
= = B % 5 4%

*10 ~ B I U

A,

B | ©c | D

m
n
[y

2171

2172

2173

2174

2175

2176

2177

2178

2179

2180

2181

2152

2183

M358 08.985 W4 30.674
M3Z 08.988 WS4 30.718
M358 08.993 WwE4 30,786
MN32 09.004 W54 30946
M35 059.013 WwE4 31.072
M35 09.015 W4 31.107
N33 09,022 WWE4 31.107
N33 09.076 w84 31.103
M33 09,163 w54 31.093
M3S 09,173 WwE4 31.109
M35 05,180 YvB4 31.200
N33 09,1583 WwiBd 31.241
N3Z 05.183 W54 31.241

2184
2185
2186
2187
2133
2189
2190
2191

4 A

+ M |4 GPS ¥V logs /

Draw~ [  AumShapes- > w [J O E 4l B & d-2£-A - == 5

Ready

Select Data>Text to Columns...
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Convert Text to Columns Wizard - Stey

The Text Wizard has determined that wour data is Fixed Width,
If this is correct, choose Mext, or choose the data type that best describes wour data,

page 11

2 x

riginal daka kype
Choose the file type that best describes your data:
" Delimited - Characters such as commas or tabs separate each Field.

v {Fixed ﬂidth} - Fields are aligned in columns with spaces bebween each Ffield.

Prewview of selected data:

M41 EEZ_8983 WE7? 25 155
41 LZ_89922 WE7? 29_ 158
41 S52_875 Wa7 35147
41l 5=2.875 W27 29,134
41 EZ_875 WET? 25 13z

= [l fen o feo e

Cancel | = Back | Mexk = I

Select “Fixed width” and press next.
Convert Text to Columns Wizard - Steg

This screen leks wou set Field widths (column breaks),

Lines with arrows signify a colurmn break,
To CREATE a break line, click at the desired pasition,

To DELETE a break line, dauble click on the line.
Ta MOVE a break line, click and drag it.

~Daka preview

USRS, ST - SN | SN DO SEU - S

Y . Y + Fy

il |EZ_ 883 7 39_1Lk5

Pl |BE_833 7 39_1L&8

Il EE_ 875 7 390147

4l |EZ_875 7 39134

pdl |EZ_875 T 3913z

il i

Cancel | < Back

A Finish |

Place arrows to separate the fields and press next.
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Convert Text to Columns Wizard - Step 2] x|

This screen lets you select each column and set olurmn data Format
the Data Format, " General

'General' converks numeric values to numbers, date 0 Tewt
walues to dates, and all remaining values ko texk,  Date: MDY -

Advanced. .. |

' Do not import column fskip

Destination: |$.ﬁ.$2 :"J

~Daka preview

Zon)
1

=
&
Pt 1
&
b
&

k1
k1
M1

Cancel | < Back. | Mexk = | Einish I

Highlight the column containing “N” and “S” and select “Do not import column (skip)”.
Press Finish.
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E2 Microsoft Excel - GPS V logs -0 x|
File Edit Yiew Insert Format Tools Data  Window Help  Adobe PDF - B X
b # - arial 10 ~ B 7 U SE=E=BE 8 % , '@ % {EE _-&-Q-,

T B & .
A2 - A 41

A | B | ¢ | o | E [ F [ 6 [ H | | =

1 —
2 41 52 0A3 a7 39155
| 3 41 52.893 a7 39.158
Ex 4 52875 a7 39147
| 5 | 41 52875 a7 39.134
B | 41 52 0875 a7 39132
7 41 52875 a7 39.132
| 8 | 41 520875 a7 39132
| 9 41 52.901 a7 39.118
10| 41 52,952 a7 39.12
11| 41 02.984 a7 39117
|12 ] 41 52.984 a7 39.103
|13 | 41 52985 a7 39.082
14 | 41 52.985 a7 39.07
| 15| 4 52 986 a7 39 .0R2
16 | 41 52,986 a7 38.991
17 | 41 52 939 a7 38797
15 | 41 52.989 a7 38.797
19| 41 52991 a7 38.859
| 20 | 41 52.989 a7 38.769

21 41 52 983 a7 38.763 -

4 4 » M[\GPSVlogs / | <] | _rlJJ

Draw~ [; AutnShapes- ~ WO OE 42 0@ d-Z-A-=S=E08 @ .
Ready Sum=35415 S

Combine degrees and minutes to digital degrees.
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E2 Microsoft Excel - GPS V logs -0 x|
File Edit Yiew Insert Format Tools Data  Window Help  Adobe PDF - B X
o2 |ﬁ1‘-.ria| v”10 v| B I U|=E== B %, WR|EE| G S & -

T B A -
PMT = ¥ A& =A2+4B2/060
: A | B [ ¢ | b [ E | F [ G | H | | =
|
2 M) 52.853] 87 39.155|=A2+EIQIBD
| 3 | 41 52.893 a7 39.158 T
EN 41 52875 a7 39.147
| 5 | 41 52875 a7 39.134
| B | 41 H2 875 a7 39.132
7 41 52875 a7 39.132
| G 41 2 875 a7 39132
| 9 41 52.901 a7 39.118
10 | 41 52,952 a7 39.12
11| 41 02.984 a7 39117
|12 | 41 52.984 a7 39.103
|13 | 41 52985 a7 39.082
14 | 41 52.985 a7 39.07
15 | 41 52 986 a7 39.062
|16 | 41 52,986 a7 38.991
|17 | 41 52989 a7 38.797
15 | 41 52.989 a7 38.797
| 19 | 41 52991 a7 38.859
| 20 | 41 52.989 a7 38.769
|21 | 41 52983 a7 38.753 -
4 4 » H[4GPS Vlogs / | _llJJ
Draw - |3  AutoShapes- . w [0 ] 4 ===
Enter S

Eliminate unused data and label columns. Because most (but not all) programs
expect longitude as “Easting”, West longitude needs to be expressed as negative
East longitude
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E3 Microsoft Excel - deletethis - 10| x|
File Edit Yiew Insert Format Tools Data  Window Help  Adobe PDF - B X
b # - arial 10 ~ B 7 U SE=E=BE 8 % , '@ % {EE _-@)'-&-,

T B A -
A1 - A 4188138333

A B | ¢ | b | E | F | 3 + % New Workbook - x
1 | 41.831381 -87.6526 | open a workbook
| 2 | 41.88155 -B7 B5Z6 deletathis
| 3| 41.83125 -87.6525 PS5 ¥ logs
| 4 | 4188125 -B7 B5ZY el
| 5| 41.83125 876522 04 Applicants
B | 4188125 -87.6522 Pringle DEM
7| 4183125 87 6522 Pringle DEM
8 | 4188168 -87.B52 for Rick
| 9 | 41.83253 -87.B52 rotate
10| 41.88307 ) -87.652 e
11| 41.88307 -87.6517 -
(12| 41.85308) -57.6514 (2 More noridecks...
| 13| 41.88303 -57 6512 REws
i 41,8831 87 E51 [ Blank workbook
| 15| 41.8831 -B57 64599 New from existing workbook
ﬂ 41.88315 -87 6466 @ Choose workbook, ..
| 17| 41.88315 -87.6466 New from template
16| 41.88318 -57.6477
(19| 41.88315 57 6462 E] General Termplates. .. .
| 20| 41.85305 876459 21 Templakes on ry Web Sites. ..
| 21 | 4180237 A7 G450 - ﬁ_—] Templates on Microsoft.com
W 4 v )\ deletethis / |« | _>|JJ| - I
Draw~ 3 | Auoshapes- > 2 O E 4l & FHE d-Z-A-=S=T B @ .
Ready A

Save the spreadsheet as text.
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Save in: I@ Desktop o B i ~ Tools ~
: Mame © | Size | Type ﬂ
ﬁl 5 1%isual Studio Projects 1KB Shortcut
History SARubbish 2 KB Shortout
just position O kKB Text Docur
j GPS ¥ logs 207 KB Text Docur
gps test 36 KB Text Docur
My Documenits etopo 29,277 KB Text Docur
(tingrid File Folder
Ctin File Falder
(1 Thermometer File Falder
(test File Falder
(temp sensar File Falder
[ 1Slopetge File Falder
Fovortes | SAMP File Falder
(Mol K145Monitor File Folder
= 4| | |
grs File narme: - qve I
My Mebwork =
Places

Save as bype: IText (Tab delimited)

LI Zancel L

The data created in this way could be read by several programs including ArcMap
but, as we’ve seen so many times before, | like Global Mapper so let's use it.

Open Global Mapper and select File>Open Generic Text ASCII file(s) and make
the selections appropriate for your data (remember we had Northings first. When
everything has been set up, click “OK” (and cross your fingers).
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Generic ASCII Text File Import Options

— Impart Tope
" Paint Only [&]l Features are Points]
" Paint, Line, and Area Features
" Elevation Grid from 30 Point Data

— Coordinate Column Order
" ¥/ Easting / Longitude Coordinate First

& / Narthing / Latitude Coordinate First

Columns to Skip at Start of Line: IIj

— Coordinate Line Prefis

- Mone. Coordinates appear immediately at the stark
of any lines in the text file that they appear in.

All coordinate lines begin with the test string
" specified below. For example, some A5CI farmats
may begin a coordinate line with X'

[ Include attributes from lines with coordinate data

[ Treat 3rd coordinate value as elevation

Select Coordinate Offzet/Scale...

page 17

— Coordinate Delimeter 0k,
Select the characters that are uzed to zeparate the
coordinates in a coordinate line from the file. Select the
Auto-Detect option if you are nat sure.
 Autg-Detect " Comma
" Space or tab " Semi-colon
{* Tab

Cancel

Help

dui

— Feature Classification
Azzign Loaded Area Features the Classification:

-
[
I

I Unknown Area Type

Azzign Loaded Line Features the Classification:

IUncIassified Linge Feature

Aszzign Loaded Point Features the Clazsification:

IUnknawn Point Feature

— Elewvation Gnd "Mo Data" Digtance Critena
Thig zetting controls how far from a known data point
that an elevation arid cell has to be befare it is
caonsidered invalid. The default zetting assumes all
arid pointz are walid. Lower values make the walid grid
stay highter around known data points.

Tight Loose

i Global Mapper - REGISTERED
File “iew Tools Search GPS Help

=10 x|

EEE SRR

v d

T,
e,
o,

R =D A |

A L,

40 krn B0 krn

|GEC (WESE4) - ( -87.82041764, 4101540401 ) [41° 00' 55,78" N, 572 49' 13.50" W
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The GPS data may now be exported to a shapefile (the same way we’ve done
several times before). My GPS uses WGS84 so | specify that for the shapefile using
ArcToolbox. This shapefile may now be read directly by ArcMap and overlain on an
appropriate base map.

= Untitled - ArcMap - ArcView - 0| x|

J Eile Edit “iew Insert Selection Tools ‘Window Help |

Ja@u@“{, By @ X |2 oo | & |[i14m018 v[|@|‘§j|\?‘

J Editor | [ | s~ | Task: [Create New Feature = | Target: | =] |/ =y |}K | ‘
=g B
B £ Layers @
B W delete this

N 5

]

[

]

[«

=

o)

Display [ Source | 302 |,|;
J@@:: DM@EnE kO MG T JQrawing' k@||:|' A'E“Aria\ == B H|£'
JSana\ Analyst = | Laer: | = 2 l‘

e 5> o 25 2| @

[ |e7o1m'38.40"W 41039'2,54"N 4
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